CyberLink

Power2Go

User's Guide
Copyright and Disclaimer

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means electronic, mechanical, photocopying, recording, or otherwise without the prior written permission of CyberLink Corporation.

To the extent allowed by law, Power2Go IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION ANY WARRANTY FOR INFORMATION, SERVICES, OR PRODUCTS PROVIDED THROUGH OR IN CONNECTION WITH Power2Go AND ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, EXPECTATION OF PRIVACY, OR NON-INFRINGEMENT. BY USING THIS SOFTWARE, YOU AGREE THAT CYBERLINK WILL NOT BE LIABLE FOR ANY DIRECT, INDIRECT, OR CONSEQUENTIAL LOSS ARISING FROM THE USE OF THIS SOFTWARE OR MATERIALS CONTAINED EITHER IN THIS PACKAGE.

The terms and conditions here under shall be governed and construed in accordance with the laws of Taiwan.

Power2Go is a registered trademark along with other company and product names mentioned in this publication, used for identification purposes and remain the exclusive property of their respective owners.

International Headquarters

Mailing Address
CyberLink Corporation
15F., No. 100, Minquan Rd., Xindian Dist.
New Taipei City 231, Taiwan (R.O.C.)

Web Site
http://www.cyberlink.com

Telephone
886-2-8667-1298

Fax
886-2-8667-1300

Copyright © 2011 CyberLink Corporation. All rights reserved.
# Contents

## Introduction ......................................................... 1

Welcome ............................................................................. 1

  Lastest Features ............................................................. 1
  Power2Go Versions .......................................................... 2

Supported Media ................................................................. 3

  Supported File Types ......................................................... 3
  Supported Disc Types .......................................................... 4

System Requirements .......................................................... 4

## Power2Go Workspace .............................................. 5

CyberLink Power2Go Modes .................................................. 6

  Power2Go Desktop Burning Gadget Mode ..................................... 6
  Power2Go Full Program Mode .................................................. 9

## Data Disc ................................................................. 15

Creating and Burning Data Discs ............................................. 15

Burning a Secured Data Disc ................................................... 16

## Music Disc ............................................................... 19

Burning an Audio CD or MP3/WMA Music Disc .......................... 19

## Video Disc ............................................................... 21

Burning a Video Disc ........................................................... 21

  Creating a Video Disc ......................................................... 22
  Selecting/Editing Disc Menus ................................................... 22
CyberLink Power2Go

Editing Disc Preferences ................................................................. 26
Burning Video to Disc ................................................................. 26
Burning a DVD Folder ................................................................. 27

Photo Gallery Disc ................................................................. 29
Creating and Burning Photo Gallery Discs ................................. 29
Viewing Photo Gallery Discs ....................................................... 32

System Recovery ................................................................. 33
Burning a System Recovery Disc ................................................ 33
Restoring Your Computer ............................................................ 34

Copy Disc ................................................................. 35
Copying Discs ........................................................................... 35
Saving a Disc Image .................................................................. 36
Burning a Disc Image .................................................................. 37

Disc Utilities ................................................................. 39
Erasing a Disc ........................................................................... 39
Ripping Audio ........................................................................... 39
Converting Audio Files ............................................................... 40
Burning Mixed Discs ................................................................. 40
  Burning a CD Extra/Mixed Mode CD .......................................... 41
Power2Go Virtual Drive ............................................................... 43
  Mounting a Disc Image ............................................................. 43
  Disabling a Mounted Disc Image ............................................... 43

Additional Burning Notes and Features ...................................... 45
Using the CyberLink ISO Viewer .................................................. 45
Multisession Discs .......................................................................................... 46

**Power2Go Settings** ................. 47

Viewing the Info Tab ......................................................................................... 47
Configuring Data Settings ................................................................................. 47
Configuring Audio CD Settings ........................................................................ 48
Configuring MP3 Disc Settings ......................................................................... 48
Configuring WMA Quality Settings .................................................................. 48
Configuring Library Settings .............................................................................. 49
Configuring Video Settings ............................................................................... 49
Configuring Common Settings .......................................................................... 49
Configuring Burner Settings ............................................................................. 50

**Technical Support** ...................... 53

Before Contacting Technical Support .............................................................. 53
Web Support .................................................................................................. 54
Chapter 1:

Introduction

This chapter introduces the CyberLink Power2Go program and includes an overview of its newest features. It also outlines the available Power2Go versions, lists the supported media types, and reviews the recommended system requirements.

Note: this document is for reference and informational use only. Its content and the corresponding program are subject to change without notice.

Welcome

Welcome to the CyberLink family of digital media tools. CyberLink Power2Go is the all-media burning software that supports all drives and discs, including CD, DVD, and Blu-ray Disc™.

With CyberLink Power2Go you can create and burn data discs, music discs, photo gallery discs, video discs, and even system recovery discs. You can also use the handy disc utilities to erase and copy discs, or to mount disc images as a virtual drive. CyberLink Power2Go is the all-in-one burning software for the PC.

Lastest Features

The latest version of CyberLink Power2Go includes many new features that make your burning tasks easier. This section describes the latest features in the CyberLink Power2Go program.

Virtual Drive

- Mount a disc image file and access it as if using a real disc drive.

Create System Recovery Disc*

- Back up your computer and Windows system files on discs.

System Recovery*

- Restore your computer from a system image on system recovery discs.
Extended Disc Image Format Support

- Support for the RDF disc image format.

Extended Codec Support*

- Support for imported videos with the H.264 and AAC codecs.

WaveEditor 2*

- Includes the latest version of this audio editing program, which includes multi-track mixing and CD creation.

Note: *optional feature in CyberLink Power2Go. Check the version table for detailed versioning information.

Power2Go Versions

The features that are available to you in CyberLink Power2Go are completely dependent on the version you have installed on your computer.

To determine your version of CyberLink Power2Go, press Ctrl+B on your keyboard or select Help > About Power2Go.

<table>
<thead>
<tr>
<th>Features</th>
<th>Platinum</th>
<th>Deluxe</th>
<th>DE (OEM)</th>
<th>LE (OEM)</th>
<th>Corp (Site License)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Disc</td>
<td>CD/DVD/BD</td>
<td>CD/DVD/BD</td>
<td>CD/DVD/BD</td>
<td>CD/DVD/BD</td>
<td>CD/DVD/BD</td>
</tr>
<tr>
<td>Virtual Drive</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Create Recovery Disc</td>
<td>Yes</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>Create Video Disc</td>
<td>CD/DVD</td>
<td>CD/DVD</td>
<td>--</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>Import H.264/AAC</td>
<td>Yes</td>
<td>Yes</td>
<td>--</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>Dolby Codec</td>
<td>Yes</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>Music Disc/ Mixed Disc</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Updating Power2Go

Software upgrades and updates (patches) are periodically available from CyberLink. CyberLink Power2Go automatically prompts you when either is available.

To update your software, do this:

1. Click the button to open the Upgrade Information window.
2. Click the feature you would like to upgrade to, or the patch you want to update CyberLink Power2Go with.
3. A web browser window opens, where you can purchase product upgrades or download the latest patch update.

### Supported Media

The following is a list of the media that is supported in CyberLink Power2Go. Note that the specific media that is supported by your version of the program is dependent on the version installed on your computer.

### Supported File Types

Except when creating data discs (which can accept any kind of file type), the following is a list of the file types that you can import when creating music, video, or photo disc in CyberLink Power2Go.

- **Audio formats**: MP3, M4A, WAV, WMA
- **Video formats**: ASF, AVI, DAT, DVR-MS, M2T, M2TS, MOV, MOD, MP4, MPE, MPEG, MPG, MTS, TS, TOD, VOB, VRO, WMV, WTV
- **Image formats**: BMP, GIF, JPE, JPEG, JPG, PNG, TIF, TIFF
Supported Disc Types
CyberLink Power2Go supports the burning of the following disc types:

- **CD**: CD-R/RW
- **Blu-ray Disc**: BDXL, BD-R, BD-R DL, BD-RE, BD-RE DL

System Requirements
The system requirements listed below are recommended as minimums for burning. You may find that your system, while meeting these recommended minimums, requires expanded capacity during specific burning tasks.

<table>
<thead>
<tr>
<th>Minimum System Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>OS</strong></td>
</tr>
<tr>
<td>• Windows 7, Vista, XP</td>
</tr>
<tr>
<td><strong>Screen Resolution</strong></td>
</tr>
<tr>
<td>• 1024 x 768 or higher</td>
</tr>
<tr>
<td><strong>Memory</strong></td>
</tr>
<tr>
<td>• 128 MB SDRAM for music and data burning</td>
</tr>
<tr>
<td>• 256 MB DDR RAM (512 MB recommended) for video burning</td>
</tr>
<tr>
<td><strong>CPU</strong></td>
</tr>
<tr>
<td>• VCD (MPEG-1) production: Intel Pentium II 450 MHz</td>
</tr>
<tr>
<td>• DVD (MPEG-2) production: Intel Pentium III 800 MHz, or AMD Athlon 700 MHz (Intel Pentium 4 2.0 GHz, or AMD Athlon 2100+ or above recommended)</td>
</tr>
<tr>
<td><strong>HDD Space</strong></td>
</tr>
<tr>
<td>• 1 GB for making VCD videos</td>
</tr>
<tr>
<td>• 5-10 GB for making DVD videos</td>
</tr>
<tr>
<td>• 25 GB for making Blu-ray Discs</td>
</tr>
</tbody>
</table>

*Note: the system requirements are subject to change. Go to the CyberLink Power2Go home page at http://www.cyberlink.com for the most up-to-date system requirements.*
Chapter 2: Power2Go Workspace

This chapter provides a complete overview of CyberLink Power2Go workspace and the available modes of the program. CyberLink Power2Go has several windows that vary slightly in appearance. However, these windows have several consistent features that make your burning experience more convenient.

When you start a new burning task in Power2Go Full Program mode (except when creating a video disc or using the disc utilities), the program displays as follows:

A - Search Pane, B Media Pane (Media on Your Computer), C - Search for Media, D - Upgrade, E - Select Disc Burner, F - Burn Now Button, G - Disc Content Area (Media to be Burned), H - Disc Capacity Indicator
CyberLink Power2Go Modes

The CyberLink Power2Go program can run in one of two modes:

- **Power2Go Desktop Burning Gadget Mode**
- **Power2Go Full Program Mode**

The Power2Go Desktop Burning Gadget mode is the simpler of the two modes, allowing you to burn discs in just two steps. The Power2Go Full Program Mode provides access to all of the burning features and disc utilities available in the program.

Power2Go Desktop Burning Gadget Mode

The Power2Go Desktop Burning Gadget makes burning discs quick and easy. It sits on your desktop (if enabled) so you can conveniently drag and drop files on to it while you work. CyberLink Power2Go prepares the media for burning, and provides instant burning when you are ready.

The Desktop Burning Gadget is available in all versions of Windows, and uses the following icons:

<table>
<thead>
<tr>
<th>Gadget Icon</th>
<th>Power2Go Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Disc</td>
<td>The <strong>Data Disc</strong> gadget. Drag and drop data files on this icon to burn them to a disc.</td>
</tr>
</tbody>
</table>
The **Audio CD** gadget. Drag and drop music files on this icon to burn an audio CD to disc that plays on a conventional CD player.

The **Video Disc** gadget. Drag and drop video files on this icon to burn them to a disc.

The **Copy Disc** gadget. Click on in this gadget to copy the contents of one disc on to another. For detailed information on copying discs, see [Copy Disc](#).

**Note:** * optional feature in CyberLink Power2Go. Check the version table for detailed versioning information.

### Enabling the Desktop Burning Gadget

When you first install CyberLink Power2Go, the Desktop Burning Gadget is automatically enabled. When it is running, the icon displays in the Windows notification area (system tray). Double-click on it to view the gadget, or right click on it for more options.

If the Power2Go Desktop Burning Gadget is not running, you can enable it by selecting the **CyberLink Power2Go 8 > Desktop Burning Gadget** option from the
Windows start menu.

**Burning with the Desktop Burning Gadget**

To burn a disc with the Desktop Burning Gadget, do this:

1. Locate the files on your computer that you want to burn.
2. Drag and drop all of the files you want on your disc to the appropriate Desktop Burning Gadget icon, i.e. music files to the Audio CD gadget, video files to the Video Disc gadget, etc.
3. Click on ![Power2Go Desktop Burning Gadget](image) in the Power2Go Desktop Burning Gadget to begin the burning process.

**Desktop Burning Gadget Burning Tips**

The following are some tips you should be aware of when burning with the Desktop Burning Gadget:

- To switch between functions in the Desktop Burning Gadget, click on the arrows at the top of the icon.
- Click on the icon in the bottom left of the Desktop Burning Gadget to open a window and view a detailed list of the content to be burned.
- All music discs burned with the Desktop Burning Gadget are in the audio CD format.
- If you drag and drop video files onto the Audio Disc icon, CyberLink Power2Go extracts the audio from the video files for burning.

**Configuring the Desktop Burning Gadget**

Right-click on the icon in the Windows notification area (system tray) to view a list of options of configuring the Desktop Burning Gadget.

The list of options include:

- **Always on Top**: select to keep the Desktop Burning Gadget on top of any other programs you are running.
• **Start Program When System Starts**: select to auto launch the Desktop Burning Gadget whenever you turn on your computer.

• **CyberLink Virtual Drive**: click to launch the CyberLink Virtual Drive window where you can mount image files and more. See [Power2Go Virtual Drive](#) for more information.

• **Erase Disc**: select to erase a re-writable disc that is currently in the disc drive.

• **About**: select to display CyberLink Power2Go version information.

• **Help**: select to open this help file.

• **Exit**: select to close the Desktop Burning Gadget.

### Power2Go Full Program Mode

The Power2Go Full Program mode is the main mode of CyberLink Power2Go where you can access all of its features.

### New Task Window

All of these features are accessed in the new task window, which displays automatically when you launch CyberLink Power2Go.

To begin a burning project, just select a task icon along the top and then the burning task you want to perform.

### Power2Go Tasks

The following is a list of the CyberLink Power2Go features you can access in the new task window:

<table>
<thead>
<tr>
<th>Task Icon</th>
<th>Power2Go Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Folder Icon" /></td>
<td>Use the <strong>Data Disc</strong> task to burn data files to a CD, DVD, or Blu-ray Disc. Data files can include any kind of document or digital file. See <a href="#">Data Disc</a> for more information.</td>
</tr>
</tbody>
</table>
The **Music Disc** task allows you to burn audio files in the MP3*, WMA, or WAV format to a CD or DVD. You can also extract audio from video files for burning or create a traditional audio CD. See [Music Disc](#) for more information.

In the **Video Disc** task window you can create a professional looking movie disc on a CD*/DVD that contains your video files. This feature also allows the burning of DVD folders to a disc. See [Video Disc](#) for more information.

Create a **Photo Gallery Disc** with your photos on a CD, DVD, or Blu-ray Disc in this task window. These discs contain a photo showcase application that runs on any computer with the included viewer. See [Photo Gallery Disc](#) for more information.

Go to the **System Recovery** task window to create a disc that you can use to restore your computer if it ever crashes and stops working. See [System Recovery](#) for more information.

You can use the **Copy Disc** task to make an exact copy of a disc if you have more than one disc drive in your computer. You can also create or burn a disc image in this task window. See [Copy Disc](#) for more information.

From the **Disc Utilities** task window you can access a number of useful features, including the erase disc, rip audio, and audio converter. This window also provides access to the CyberLink virtual drive, and is where you can create and burn mixed and CD extra discs. See [Disc Utilities](#) for more information.

**Note:** *optional feature in CyberLink Power2Go. Check the version table for detailed versioning information.*

## Using the Search Pane

The search pane is available in most of the main CyberLink Power2Go windows and
is a useful tool that can help you find the media you want to burn to a disc quickly. The search pane may have any of the following three tabs: **Browse**, **Filter**, and **Media**.

**Note:** you can also enter in keywords in the search media field to search for files in a specific folder on your computer.

### Browse Tab

On the **Browse** tab you can navigate through the drives and folders on your computer. It is similar to Windows Explorer, and when you select a folder, the files (in the supported format for the selected disc type) display in the media pane.

### Filter Tab

The **Filter** tab is available when you are burning data discs. On this tab you can filter the type of data files you want to include on your disc to simplify the search process.

Select **All files** if you want to view all the files in a folder, or select **Custom files** and then select the file types from the list you are searching for. Click **Edit** to customize the list of file extensions that CyberLink Power2Go uses to filter. You can add or remove file extensions from the filter list by selecting the **Edit** button and making the changes as required.

### Media Tab

Use the **Media** tab when creating music discs to quickly find the music files you are looking for. CyberLink Power2Go uses the CyberLink Media Library service to categorize your music by artist, album, genre, year, and recently added.

**Note:** you can set the folders that are available in the CyberLink Media Library in settings. See **Configuring Library Settings** for more information.

### Power2Go Projects

When creating discs for burning in the CyberLink Power2Go main window, you can save burning projects in the P2G format so that you can edit and burn them at a later date.

To do this, select **Project > Save** or **Save As** from the menu. To open a project you created previously, select **Project > Open** from the menu.
CyberLink Power2Go

**Power2Go User Preferences**

CyberLink Power2Go offers several preferences to suit the program to your working methods. To view the program’s preferences, select `Project > Preferences` from the menu.

**General Preferences**

On the **General** tab, set the general preferences as follows:

- **Temporary directory**: allows you to set a working directory that CyberLink Power2Go uses to save temp files during the burning process.
- **Reset all "Do not ask me this question next time"**: if you selected this option in a window during the disc creation process, this option allows you to reset them all. Click **Reset** and these windows will begin to display again.

**Capacity Preferences**

On the **Capacity** tab you can set a custom disc size when burning content to CD, if you are using discs that can hold more than 700 MB. The preferences are as follows:

- **Auto detection**: enables CyberLink Power2Go to automatically detect a disc’s capacity.
- **Customize CD-R/RW capacity**: select this option and then enter the new size (in minutes) in the field provided to manually set a disc’s capacity.

**Database Preferences**

On the **Database** tab, set the Internet connection preferences as follows:

- **Automatically retrieve album/disc information from the Internet**: select this option to have CyberLink Power2Go automatically retrieve song and album information when ripping audio files.

**Language Preferences**

On the **Language** tab, set your user interface language preferences as follows:

- **Use system default language**: select this option if you want the CyberLink
Power2Go language display to be the same as the default language of your operating system.

- **User defined**: select this option and then select the language from the drop-down list that you want CyberLink Power2Go to use.
Chapter 3:

Data Disc

The Data Disc option allows you to burn data files to a CD, DVD, or Blu-ray Disc. Data files can include almost any kind of document or digital file. You can also create a secured data disc if you are burning content sensitive or import files to a disc.

Creating and Burning Data Discs

To burn a data disc, do this:

1. In the new task window, click the Data Disc option and then select the type of disc (CD, DVD, Blu-ray Disc) you want to create. The Data Disc window opens.

2. Use the search pane (see Using the Search Pane for more information) to find the files you want to include on your disc. Select the files or folders you want to burn and then drag and drop them in the disc content area.

   **Note:** you can also click the button to add the data files or click the button to create a folder on the disc.

3. After you have added all of the content that you want to burn, click the Burn now button.

4. If required, adjust the settings on the Data, Common, or Burner tabs (see the related sections in Power2Go Settings for more information.)

5. Click Burn when you are ready to burn your disc.

   **Note:** select the Auto shut down after burning option if you want CyberLink Power2Go to automatically shut down your computer once it has successfully burned your disc.

6. When the burning is complete, select one of the following options in the window that opens:

   - Click View Log to view the burning log. The log opens in your default TXT editor, where you can view and save it.
   - Click OK to close the window.
Burning a Secured Data Disc

The secured data disc option allows you to burn password-protected data files to a CD, DVD, or Blu-ray Disc.

You can also burn secured data disc with encrypted file names. The encrypted file names are hidden from users, unless they enter the correct password. You can choose to secure all or only some of the files on a data disc.

Burning Secured Data Discs

To burn a secured data disc, do this:

1. In the new task window, click the Data Disc option and then select the type of disc (CD, DVD, Blu-ray Disc) you want to create. The Data Disc window opens.

2. Click the button.

3. Select the level of security for the disc: Secured (128-bit) or Highly secured (256-bit).

4. Enter a Password for your secured data disc. Re-enter the password again in the Confirm password field and, if required, include a Password reminder, which can assist you if you ever forget it.

5. Select the Hide the file names on a secured disc checkbox if you want to encrypt the file names on the disc.

6. Click OK. Note that the disc content area is split into two sections.

7. Use the search pane (see Using the Search Pane for more information) to find
Data Disc

to the files you want to include on your disc. Select the files or folders you want to burn and then drag and drop them to either the secured data area (indicated in pink) or the regular non-secured data area (indicated in blue).

Note: you can also click the button to add the data files or click the button to create a folder in the last disc area you selected.

8. Once you have added all of the content that you want to burn, click the Burn now button.

9. If required, adjust the settings on the Data, Common, or Burner tabs (see the related sections in Power2Go Settings for more information.)

10. Click Burn when you are ready to burn your disc.

Note: select the Auto shut down after burning option if you want CyberLink Power2Go to automatically shut down your computer once it has successfully burned your disc.

11. When the burning is complete, select one of the following options in the window box that opens:

- Click View Log to view the burning log. The log opens in your default TXT editor, where you can view and save it.

- Click OK to close the window.

Viewing Content on a Secured Data Disc

When you burn data to a secured disc with CyberLink Power2Go, the CyberLink Secure Browser is included on the disc so that you can view the content on the disc.

1. When you insert a secured data disc into the disc drive, the CyberLink Secure Browser prompts you for a password.
Note: if the CyberLink Secure Browser does not automatically launch when you insert a secured data disc, try navigating to the disc in Windows Explorer and then double-click on the disc in the drive to launch it manually.

2. Enter your password and then click OK to display the CyberLink Secure Browser window.

3. In the CyberLink Secure Browser, you can perform the following functions:

   - Click to view a file in its default program.
   - To extract files from the disc and save them to a computer, select them and then click .

   Note: if you selected to Hide the file names on a secured disc when creating the disc, double-click on the secured folder in the list view to view the files.

   - Click to search for files. Type part or all of the file name or folder in the field provided. When searching you can click Size to look for files of a specific size, or Modified Date to look for files that were created or modified on or between specific dates.

     Note: to change the view of the items in the CyberLink Secure Browser, click .
Chapter 4:

Music Disc

The Music Disc option allows you to create an MP3 or WMA CD/DVD with your music files, or create a traditional audio CD that plays back on a regular CD player.

Burning an Audio CD or MP3/WMA Music Disc

To burn an audio music CD or MP3/WMA music disc, do this:

1. In the new task window, click the Music Disc option and then select the type of music disc you want to create (Audio CD, WMA CD, MP3 CD, WMA DVD, MP3 DVD). The Music Disc window displays.

2. Use the search pane (see Using the Search Pane for more information) to find the music you want to include on your disc. Select the files you want to burn and then drag and drop them in the disc content area.

   **Note:** you can also click the button to add the music files or the other available buttons to reorder and preview the music on the disc. If you want to extract the audio from a video clip and include it on your music disc, simply add the video clip to the disc.

3. If you would like to edit or add effects to a music file, select it and then click the button to edit it in CyberLink WaveEditor*. Please consult the help file in CyberLink WaveEditor for detailed information on editing audio in that program. Once you finish editing an audio file, the updated file is placed back in the disc content area.

4. Once you have added all of the content you want on your disc, click the Burn now button.

5. If required, adjust the settings on the music (Audio CD, MP3 Disc, WMA Quality), Common, or Burner tabs (see the related sections in Power2Go Settings for more information).

6. Click Burn when you are ready to burn your disc.
7. When the burning is complete, select one of the following options in the window that opens:

- Click **View Log** to view the burning log. The log opens in your default TXT editor, where you can view and save it.
- Click **OK** to close the window.

**Note:** *optional feature in CyberLink Power2Go. Check the version table for detailed versioning information.*
Chapter 5:

Video Disc

The Video Disc* option allows you to burn video files to CD or DVD, along with a stylish disc menu. You may also burn a DVD folder to a disc.

**Note:** *optional feature in CyberLink Power2Go. Check the version table for detailed versioning information.*

Burning a Video Disc

When you select the Video CD (VCD) Disc* or DVD-Video Disc* option in the new task window, the create disc window displays.

---

A - Disc Content Tab, B - Menu Preferences Tab, C - Disc Preferences Tab, D - Disc Menu Font
The steps to create and burn a video disc may vary depending on your requirements. The following sections outline all of the features you can perform in the create disc window, so consult the sections that apply to the disc you want to create.

Creating a Video Disc

To create a video disc, do this:

1. In the new task window, click the Video Disc option. Select either the Video CD (VCD) Disc or DVD-Video Disc option to open the create disc window.

2. Click the button and then browse to and select the video file that you want to include on the disc.

3. Click on to preview the imported video, if required.

4. Click the button to import additional video files if required. Each video you import becomes another title or scene on your final disc.

5. Proceed to complete the disc creation process as required. See Selecting/Editing Disc Menus for more information.

Selecting/Editing Disc Menus

Once you have added all of the content that you want on your disc, click on the Menu Preferences tab to edit the existing disc menu or select another disc menu template.

All the disc menu templates in CyberLink Power2Go are multi-layered, and consist of the following pages:

- a main menu home (root) page.
- a scenes page that lets you select the individual titles (videos) on your disc.
Selecting Disc Menu Templates

CyberLink Power2Go provides you with several stylish pre-designed menu templates that you can choose from. These menus are already customized for you and may include such features as motion and menu music.

*Note:* if you do not want to include a menu on your final disc, select the No Menu template on the Menu Preferences tab.

Select a menu template to preview it. Select Apply to apply the highlighted menu page style to the specified menu page. Select Apply to All Pages if you want to use the same style on every page (home and scenes page).

*Note:* if required, you can click on go to DirectorZone, where you can download and import additional disc menu templates.

Editing Disc Menu Properties

CyberLink Power2Go lets you edit some of the disc menu’s properties. Use the menu navigation controls to preview the design and behavior of the current disc menu.

If you want to view the scenes on your disc, use the button and the other menu navigation controls to navigate through the disc menu. Or click the Preview button at the bottom of the window to view what your disc will look like when played on a disc player after burning.

Editing Disc Menu Text

To edit the text that appears on the menu page, including clickable button text, double-click on it, and then enter the new text. You can modify menu text style, size, and alignment using the disc menu font properties options located at the top of the disc menu window.

To change the position of any text on your menu, just click and drag it to the new position.

Setting Disc Menu Background Music

Some of the pre-designed disc menu templates contain menu music. In the disc menu properties are you can:
• click on \( \text{+} \) to edit or replace the menu’s background music.

• click \( \text{-} \) to remove the current background music from the menu.

### Adding/Editing Disc Menu Music

If you are using background music in your disc menu, click the \( \text{+} \) button to perform the following functions:

- **Note:** the final duration of your disc menu’s background music is dependent on the time entered in the **Duration** field in the Playback Mode Settings window, not the length of the music file used. See **Setting Disc Playback Mode** for more information on setting your menu’s duration.

- click the \( \text{+} \) button to add/replace the menu background music.

- trim the audio file using the playback controls and then move the sliders on the trim bar to the desired start and end points.

- select to have the menu music gradually **Fade-in** or **Fade-out**.

- if the length of your menu music file is not as long as the specified duration, select the **Auto repeat** option to loop it.

- click **Apply to All Pages** to set the music for all of the disc menu pages, or click **Apply** to set it for the current disc menu page you are editing.

### Adding a First Play Video

Use this option to add a video as a first play video to your created disc. The first play video plays automatically when the disc is inserted into a disc player, before the disc menu loads. No navigation buttons are available during the first play, and viewers cannot fast forward past this segment. In a professional production, this is usually a copyright notice or warning. However, you may prefer to use a personal introduction or other video clip instead.

To set a clip as first play, do this:

- click \( \text{\textbullet\textbullet\textbullet} \) and select the video that you want.

- click \( \text{-} \) to remove the video set as the first play video.
• click play to preview the first play video.

**Setting Disc Playback Mode**

Click the button to set how the disc plays back in a disc player. Select from one of the available playback modes in the list.

In the Playback Mode Settings window you can set the following:

• choose from one of the three available playback modes based on the available descriptions. Your disc will follow the selected behavior when inserted or play is pressed on your disc player.

• if you want the disc content to play automatically, select the **Auto menu time out** option. When selected, your disc content plays automatically after displaying the disc menu for the specified duration. If you do not select this option, your menu loops endlessly until you press the play button on your disc player.

• in the **Duration** field, enter in the length in seconds for the disc menu. The minimum duration allowed is 10 seconds, while your disc menu can be up to 99 seconds long before it loops back to the beginning.

*Note:* the duration you enter is also the length of your menu’s background music, even if the selected music file’s length is longer than the duration specified.

**Specifying Buttons Per Page**

When creating a disc with multiple titles /scenes, you can select the number of thumbnail buttons that display on the scenes menu page. Use the **Buttons per page** drop-down at the bottom of the **Menu Preferences** tab, to select the number you want on these pages.

*Note:* the number of thumbnail buttons that can display on each menu page is dependent on the design of the menu template.

Select **Add thumbnail index** to add numbering of your thumbnails to your menu page.
Editing Disc Preferences

Before you burn a disc you should configure your disc preferences, including disc and video file format, audio format, etc. Click on the Disc Preferences tab to configure your disc’s preferences.

The following preferences are available on the Disc Preferences tab:

Disc Format

- the format of your disc was determined by the option you selected on the new task page (Video CD (VCD) Disc/DVD-Video Disc). Depending on the disc format that you selected, there may be a drop-down option to select the capacity of the disc.

Video and Audio Settings

- Select the video recording format: if available for your selected disc format, select the recording format of the video on your disc and its aspect ratio.

- Select the video encoding format and quality: if available for your selected disc format, select an encoding format and video quality for your disc. The Smart Fit option automatically adjusts the bit rate to the best quality video file that fits exactly to the capacity of the disc you are using.

- Select the audio encoding format and channels: select an audio format for your disc, and the number of channels it is capable of outputting to.

\[\text{Note: the video quality and audio type options that are available depend on the disc format that you have selected.}\]

- TV Format: select the TV format (NTSC or PAL) for your video. This format should correspond to the region in which you plan to play your video disc.

Burning Video to Disc

Burning the disc is the final stage of the create disc process. Once your disc is burned, you are able to play it on a disc player. Click on the Burn button and then on Start Burning to begin the burning process.

\[\text{Note: the burning process may take at least a few minutes, depending on the length and quality of your video, and your computer’s processing power. Be prepared for a short wait while CyberLink Power2Go renders your video disc.}\]
Configuring Burn Settings

Before you burn to a disc for the first time, it is advised that you click on [ ] to set your burning settings. After you configure these settings, CyberLink Power2Go uses the same settings each time you burn until you change them.

Erasing Discs

If you are using a rewritable disc, you can erase content that has data previously recorded on it. This allows you to reuse the same discs over and over without the need to continually buy new discs. Click on the [ ] button to begin erasing a disc.

When erasing a disc, select:

- the **Quick erase** option to erase the disc index contained on the disc.
- the **Full erase** option to erase all of the content the disc contains.

Burning a DVD Folder

A DVD folder is a directory folder specifically created to store media content of a DVD, like a backup. Using the **Burn DVD Folder** utility you can burn a DVD folder to a DVD disc.

**Note**: *optional feature in CyberLink Power2Go. Check the version table for detailed versioning information.*

To burn a DVD folder, do this:

1. In the new task window, click the **Video Disc** option. Select the **Burn DVD Folder** option to open the Burn DVD Folder window.

2. Click and then select the DVD folder on your computer that you want to burn to a disc.

3. Enter a **Disc name** in the field provided.

4. Insert your disc and then select your drive in the drop-down list.

5. If required, set the **Write speed** and the **Number of copies** you want to burn.
6. Select **Perform write simulation** if you want CyberLink Power2Go to simulate the burning process first to ensure the burn will finish successfully.

7. Click **Burn** to start the burning process.

8. When burning is complete, select an option in the window that opens:
   - Click **View Log** to view the burning log. The log opens in your default TXT editor, where you can view and save it.
   - Click **OK** to close the window.
Chapter 6:

Photo Gallery Disc

With the **Photo Gallery Disc** option you can use your photos to create a dynamic slideshow that is burned as a stand-alone photo showcase application on a CD, DVD, or Blu-ray Disc. The photo gallery runs on any computer with the included viewer, and can include photo descriptions and an external URL on the disc.

**Note:** *optional feature in CyberLink Power2Go. Check the version table for detailed versioning information.*

Creating and Burning Photo Gallery Discs

When you create a photo gallery disc, you are essentially creating a photo album on a disc. You can create more than one album on a single photo gallery disc.

To create and burn a photo gallery disc, do this:

1. In the new task window, click the **Photo Gallery Disc** option and then select the type of disc (**CD**, **DVD**, **Blu-ray Disc**) you want to create. The Photo Gallery Disc window opens.

2. In the Disc Compilation pane, if required, enter a custom name for the photo album that will appear on the disc.

3. Use the search pane (see **Using the Search Pane** for more information) to find the photos you want to include on your disc. Select the photos you want to burn and then drag and drop them in the disc content area (Click the **button to switch to the thumbnail view to make it easier to find the exact photos you are looking for).

**Note:** you can also click the **button to add the photos. Ensure that you have the album you want to add the photos to selected in the Disc Compilation pane before adding your photos.

4. Repeat the last two steps to add more photos to an album as required. You can also click the **button to create a new album on the disc.

5. After you have added all of the photos you want on your disc, click the **Burn now** button.
6. Click on the **Gallery** tab and then configure the photo gallery disc settings as follows:

- **Gallery title**: enter in a title for your photo gallery. The title displays on your disc after it is burned.

- **Custom Logo**: click on the **Custom Logo** button to customize the logo used in your photo gallery, as follows:
  - **Don't include logo in photo gallery**: select this option if you don’t want to include a logo in your created photo gallery.
  - **Include logo in photo gallery**: select this option if you want to include a logo in your created photo gallery. Click the button to select an image to use as the logo, replacing the default CyberLink logo.
  - **Include URL link on logo**: select this option if you want to include a URL link on the logo. Once selected, enter the URL address in the field provided. When users click on the logo in the created photo gallery, they are taken to the specified URL.

- Click **OK** to save your changes.

- **Slideshow speed**: enter the duration, in seconds, you want each photo or slide to display when your photo gallery is played as a slideshow.

- **Background image**: click the **Change** button to set the image that is used as the background in the photo gallery. If none of the default images suit your gallery disc, click the **Browse** button to use your own custom image.

- **Display EXIF information**: if the images were taken with a digital camera that supports EXIF, select this option if you want the image details displayed in your photo gallery disc.

- **Add background music**: if you want music to play in the background as users browse through your photo gallery disc, select this option and then click **Browse** to select the music file you want to use.

- **Include editor’s note**: if you want to include a note or description about your photo gallery, select this option, click **Edit**, and then enter the **Title** and **Content** (note/description) in the fields provided.
• **Include external URL**: if you want to include a web site link on the photo gallery disc, select this option, click **Edit**, and then enter the web site **Name** and URL (**http://**) in the fields provided.

• Click the **Preview** button if you want to view what your photo gallery disc will look like once it is burned to a disc. Click **Export** to create the stand-alone photo gallery application in a folder on your hard drive.

7. If required, adjust the settings on the **Common** and **Burner** tabs (see the related sections in **Power2Go Settings** for more information).

8. Click **Burn** when you are ready to burn your disc.

---

**Note**: select the **Auto shut down after burning** option if you want CyberLink Power2Go to automatically shut down your computer once it has successfully burned your disc.

9. When the burning is complete, select one of the following options in the window box that opens:

• Click **View Log** to view the burning log. The log opens in your default TXT editor, where you can view and save it.

• Click **OK** to close the window and then exit.
Viewing Photo Gallery Discs

Once you create a photo gallery disc, to view it all you need to do is insert the disc into a computer’s disc drive. The photo gallery viewer will play the disc automatically.

If your disc does not play automatically or you exported the application to your drive, just browse to the CL_Gallery.exe on the disc/hard drive and double click it to view the photo gallery.
Chapter 7:

System Recovery

The System Recovery feature in CyberLink Power2Go is a computer system backup and recovery solution that helps protect your computer, and its data, against unforeseen events, such as virus attacks, system crashes, and hard disk failures.

CyberLink Power2Go helps you create and burn a system recovery disc that includes the Windows operation system programs and a backup of all the data files that are currently on your computer.

Note: * optional feature in CyberLink Power2Go. Check the version table for detailed versioning information.

Burning a System Recovery Disc

To back up your computer and burn a system recovery disc, do this:

1. In the new task window, click the System Recovery option and then select Burn Recovery Disc. The first Burn Recovery Disc wizard window opens.
2. Click the Next button to proceed to the next wizard window.
3. If required, select your burning drive from the first drop down.
4. Select the Disc type you want to back up the Windows files and data on from the drop-down.

Note: the disc type you select should be based on the burning drive you have installed in your computer and the type of optical discs you have on hand.

5. Enter any Backup notes that you may want to include on the recovery discs, such as the computer name or the date the backup was performed.
6. Click the Start Backup button to begin backing up your computer and burning the system recovery discs. If more than one disc is required to create the system recovery discs, you will be prompted to insert the next disc to proceed.
7. Continue to follow the steps in the wizard windows to finish the backup process. Click Done once finished.
Restoring Your Computer

To restore your computer from a system recovery disc, do this:

1. Insert the first system recovery disc created previously into your computer's disc drive.
2. Restart your computer.
3. The System Recovery Restore wizard will display once your computer has restarted.
4. Click the **Next** button to proceed, and then **Start** to begin the restoration process.
5. Follow all the steps in the wizard to restore your computer.
6. Once the restore is complete, click **Shut Down** to turn off your computer or **Reboot** to log back into Windows.

*Note: if you want to reboot your computer, make sure you remove the system recovery disc from the disc drive.*
Chapter 8: Copy Disc

The Copy Disc function allows you to make an exact copy of a disc. However, you must copy the disc contents onto a blank disc of the same disc type. (You cannot, for example, copy content from a CD onto a DVD.) The Copy Disc function also allows you to save or burn disc images.

**Note:** some discs may not be copied if they are copy-protected or contain errors.

Copying Discs

With CyberLink Power2Go you can copy and burn the entire contents of a disc onto another disc. You can perform this function in both Power2Go Full Program mode and using the Desktop Burning Gadget. Only the first step for opening the Copy Disc window is slightly different.

To copy a disc, do this:

1. Open the Copy Disc window by:
   - selecting the **Copy Disc** option, and then **Copy Disc** in the new task window when in Power2Go Full Program mode.
   - selecting the button on the Desktop Burning Gadget until the Copy Disc gadget displays, and then clicking on to open the Copy Disc window.

2. Select your source and target drives using the **From** and **To** drop-downs.

3. Select a Read speed and Write speed for each disc. The speeds you should select will depend on the burning drives you are using and the quality of the discs.

4. Select Ignore reading error if you want CyberLink Power2Go to copy the disc even if errors are encountered.

5. Select the Copy to hard disk option, if available, to also save a copy of the disc to your computer’s hard drive.

6. Select **Copy whole disc** if you want to copy the entire contents of the disc onto the destination disc.
7. Enter the **Number of copies** you want to burn.

8. If available, you can use the following options to assist with the burning process:

   - select **Perform write simulation** if you want CyberLink Power2Go to simulate the burning process first to ensure the burn will finish successfully.
   - if available, select **Verify recorded data** if you want CyberLink Power2Go to verify that the content was successfully burned to the disc.
   - if available, select **Enable defect management** to have CyberLink Power2Go try to fix any defects on a disc so that content burns correctly.

9. Click **Copy** to begin the copy and burn process.

10. When burning is complete, select an option in the window that opens:

    - Click **View Log** to view the burning log. The log opens in your default TXT editor, where you can view and save it.
    - Click **OK** to close the window.

---

**Saving a Disc Image**

Saving a disc image is useful if you want to back up your discs on your computer’s hard drive.

To save a disc image, do this:

1. In the new task window, select the **Copy Disc** option and then **Save Disc Image**.

2. Insert a disc into the disc drive and then, if necessary, select your source drive in the **From** drop-down.

3. Select **Ignore reading error** if you want CyberLink Power2Go to copy the disc even if errors are encountered.

4. Select **Copy whole disc** if you want to save the entire contents of the disc in the image file.

5. Click **...** to set the folder where you want to save the image, and then enter
in an image file name if required.

6. Choose the file format for the image file (P2I or ISO) from the **Save as type** drop-down.

7. Click **Save** to save the disc image.

---

**Note:** select the **Auto shut down after burning** option if you want CyberLink Power2Go to automatically shut down your computer once it has successfully burned your disc.

8. When saving is complete, select an option in the window that opens:

- Click **View Log** to view the log. The log opens in your default TXT editor, where you can view and save it.
- Click **OK** to close the window.

---

**Burning a Disc Image**

A disc image is a file on your computer that is the duplicate of the contents and file structure of a disc. CyberLink Power2Go lets you burn a disc image to a disc.

---

**Note:** you can view the contents of an image file using the CyberLink ISO Viewer. See **Using the CyberLink ISO Viewer** for more information on this feature.

---

To burn a disc image, do this:

1. In the new task window, select the **Copy Disc** option and then **Burn Disc Image**.

2. Click ![...](image) to select the disc image you want to burn to a disc.

3. Insert your disc and select your drive in the drop-down in the **To** section.

4. Select a **Write speed** for burning the disc. The speed you should select will depend on the burning drive you are using and the quality of the disc.

5. Enter the **Number of copies** you want to burn.

6. If available, you can use the following options to assist with the burning process:

- select **Perform write simulation** if you want CyberLink Power2Go to simulate the burning process first to ensure the burn will finish successfully.
CyberLink Power2Go

- select **Verify recorded data** if you want CyberLink Power2Go to verify that the content was successfully burned to the disc.

- select **Enable defect management** to have CyberLink Power2Go try to fix any defects on a disc so that content burns correctly.

7. Click **Burn** to start the burning process.

---

**Note:** select the **Auto shut down after burning** option if you want CyberLink Power2Go to automatically shut down your computer once it has successfully burned your disc.

---

8. When burning is complete, select an option in the window that opens:

- Click **View Log** to view the burning log. The log opens in your default TXT editor, where you can view and save it.

- Click **OK** to close the window.
Chapter 9:

Disc Utilities

In addition to the wide range of disc burning functions, CyberLink Power2Go offers some handy utilities for managing your discs, including erasing re-writable discs, ripping audio from music CDs, and converting audio files to other formats. The Disc Utilities window also provides access to creating mixed discs, and the CyberLink Power2Go Virtual Drive.

Erasing a Disc

If you are using a re-writable disc, you can erase content that was previously recorded onto it. This allows you to reuse the same discs over and over without the need to continually buy new discs.

To erase a disc, do this:

1. In the new task window, select the Disc Utilities option and then Erase Disc.
2. Insert your disc and select your Burner from the drop-down.
3. Select one of the following erase methods:
   - Quick erase: erases the disc index contained on the disc.
   - Full erase: erases all of the content the disc contains.
4. Click Erase to start the erase process.

Ripping Audio

The Rip Audio function copies audio tracks from an audio CD to your hard drive in MP3, WAV, or WMA format.

To rip audio files to your hard drive, do this:

1. In the new task window, select the Disc Utilities option and then Rip Audio.
2. Insert your disc and then select your drive from the Source drop-down.
3. Select the audio tracks that you want to copy to your hard drive.

4. Click the button and locate the folder that you want to copy the audio tracks to.

5. In the Settings section, set the Format and Quality of the outputted audio files.

6. Click Go to copy the files to your computer.

**Converting Audio Files**

Use the Audio Converter utility to convert audio files to different audio formats. You can also output audio files with a different quality or extract audio from video clips.

To convert audio files, do this:

1. In the new task window, select Disc Utilities option and then Audio Converter.

2. Click and then select the files you want to convert. Click Open to add them into the Audio Converter window.

3. Click the button and then select the location where you want to save the converted audio files.

4. In the Settings section, set the Format and Quality of the converted files from the drop-downs.

5. Click Go to convert the audio files and save the files to your computer.

**Burning Mixed Discs**

In the Disc Utilities window you can also create and burn mixed discs (CD Extra and Mixed Mode CD). Mixed discs allow you to burn different types of media content (data files and audio CD) to the same disc.

With the CD Extra feature you can create an audio CD that also contains your data
files. The Mixed Mode CD allows you to create a data CD that also contains audio files in audio CD format. These discs allow you to play the music on your computer with the proper playback software, and also view the data files like a normal data disc.

**Burning a CD Extra/Mixed Mode CD**

To burn a CD Extra or Mixed Mode CD disc, do this:

1. In the new task window, select the Disc Utilities option and then CD Extra or Mixed Mode CD. The CD Extra/Mixed Mode CD window opens.

2. If you’re creating a CD Extra disc, do this:
   - Drag and drop audio files to the middle pane. (Dragging a folder to the pane adds the files it contains, but does not create a folder on the disc.)
   - Drag and drop data files and folders to the bottom pane. (Dragging a folder to the pane creates a folder on the disc.)

   **Note**: if you add music files to the data pane, you cannot play them on a CD player, as they are read as data files.

3. If you’re creating a Mixed Mode CD, do this:
   - Drag and drop data files and folders to the middle pane. (Dragging a folder to the pane creates a folder on the disc.)
   - Drag and drop audio files to the bottom pane. (Dragging a folder to the pane adds the files it contains, but does not create a folder on the disc.)

   **Note**: you can also click the button to add the files or the other available buttons to reorder and preview the music on the disc.

4. If you would like to edit or add effects to an audio file, select it and then click the button to edit it in CyberLink WaveEditor*. Please consult the help file in CyberLink WaveEditor for detailed information on editing audio in that program. Once you finish editing an audio file, the updated file is placed back in the disc content area.

5. Once you have added all of the content you want on your disc, click the Burn now button.

6. If required, adjust the settings on the **Data, Audio CD, Common** and **Burner** tabs (See Power2Go Settings for more information.)
7. Click **Burn** when you are ready to burn your disc.

   * **Note:** select the **Auto shut down after burning** option if you want CyberLink Power2Go to automatically shut down your computer once it has successfully burned your disc.

8. When burning is complete, select an option in the window that opens:

   - Click **View Log** to view the burning log. The log opens in your default TXT editor, where you can view and save it.
   - Click **OK** to close the window.

   * **Note:** *optional feature in CyberLink Power2Go. Check the version table for detailed versioning information.*
Power2Go Virtual Drive

The Power2Go Virtual Drive lets you mount a disc image file and access it as if it is a real disc drive on your computer.

Mounting a Disc Image

To mount a disc image using the Power2Go Virtual Drive, do this:

1. In the new task window, select the Disc Utilities option and then Virtual Drive. The Power2Go Virtual Drive window displays.
2. Select the Enable virtual drive option.
3. In the Image location field, click and select the location of the image you want to mount. CyberLink Power2Go supports the mounting of images in the ISO, P2I (Power2Go image) or RDF formats.
4. Assign a Drive letter for the mounted disc image, by selecting it from the drop-down. The drive letter you assign will be how you identify the mounted drive in Windows Explorer.
5. Click on OK to mount the drive. The disc image will be available like any other disc drive in Windows Explorer.

Note: the disc image stays mounted as a drive until you disable it, even if you reboot your computer.

Disabling a Mounted Disc Image

To disabled a mounted disc image, do this:

1. In the new task window, select the Disc Utilities option and then Virtual Drive. The Power2Go Virtual Drive window displays.
2. Select the Disable virtual drive option.
3. Click on OK.
Chapter 10:

Additional Burning Notes and Features

The following are some additional burning notes and features for CyberLink Power2Go that you may find extremely useful when burning discs.

Using the CyberLink ISO Viewer

With CyberLink Power2Go you can use the CyberLink ISO Viewer to view disc images in the ISO, P2I (Power2Go image) or RDF format on your computer’s hard drive. This convenient tool lets you view the contents of an image file, and quickly extract files or burn the image to a disc.

You can launch the CyberLink ISO Viewer by selecting CyberLink Power2Go > ISO Viewer option from the Windows start menu, or right-clicking on an image file on your hard drive and then selecting ISO Viewer.

When in the CyberLink ISO Viewer, you can perform the following functions:

- click the button to browse to and open an image file (in the ISO, P2I or RDF format) on your computer. When opened, you can see all the files contained within the image.
Note: to change the view of the files in the CyberLink ISO Viewer, click 

- click on a file in the CyberLink ISO Viewer and then click to view it in its default program.

- to extract files from the image and save them to your computer, select them and then click 

- if you want to burn the image you are viewing to a disc, click the button. See Burning a Disc Image for more detailed information about burning disc images.

- if you want to mount the image as a drive on your computer, click the button. See Mounting a Disc Image for more detailed information about mounting disc images.

**Multisession Discs**

When you burn a data disc in CyberLink Power2Go, you can create a multisession disc that lets you burn additional content to a disc that is not full. CyberLink Power2Go creates a multisession disc whenever you burn a CD, DVD or Blu-ray Disc and choose not to close the disc.

With multisession discs you can continue to add content it until the disc is full or closed, at which point you can no longer add any further data.
Chapter 11:

Power2Go Settings

This chapter outlines the steps for configuring the settings used to burn discs in CyberLink Power2Go. To open the Settings/Information window, click the button in the new task window, select **Burning > Settings** when creating a disc, or press Ctrl+I on your keyboard.

**Note:** only the **Info** tab displays if you have not selected a burning task. The tabs that display and the available options they contain depend on the burning task you select.

### Viewing the Info Tab

The **Info** tab displays the details and specification of the selected disc drive, the disc in the drive, as well as the current project. Click the + next to an item to view more detailed information.

If you insert a new disc or select a different drive, click to refresh and ensure that the most updated information is displayed.

### Configuring Data Settings

The **Data** settings tab displays before burning a Data or Mixed Disc. On this tab, configure the settings as follows:

- **Make auto-run disc:** select this option to create a data disc that opens a data file (that you added during creation) when the disc is inserted into a drive. Click **Browse** to select the file you want to open when the disc is inserted. The file can be an EXE, HTML or TXT file, and opens automatically when the burned disc is inserted.

- **Change disc icon:** you can change the icon that appears when this disc is viewed in Windows Explorer. Click **Browse** and then select the image in the ICO file format that you want to use.

- **File system:** set the file system (ISO9660/Joliet, UDF 1.5, UDF 2.0, UDF 2.5, or UDF 2.6) you want the disc to have.

- **Auto-split content by disc capacity:** select this option to automatically divide the files you are burning into volumes (portions) according to the size of the
Configuring Audio CD Settings

The Audio CD settings tab displays before burning an audio CD to a disc. On this tab, configure the settings as follows:

- **Enable CD text**: select this option if you want to add information about the music disc you are creating. Enter the desired information in the fields provided.

- **Normalize volume in all tracks of the CD**: select this option to set the volume of all of the audio tracks on the CD to the same level.

- **Auto-split content by disc capacity**: select this option to automatically divide the files you are burning into volumes (portions) according to the size of the destination disc.

- **Insert audio gap between tracks**: enter the duration, or silence, between each track in seconds in the field provided.

Configuring MP3 Disc Settings

The MP3 Disc settings tab displays before burning an MP3 disc. On this tab, configure the settings as follows:

- **Quality**: select the sound quality of the MP3 files that are burned to the disc from the drop-down.

- **Auto-generate playlist**: select this option if you want CyberLink Power2Go to create a playlist with the songs that will be on your disc.

Configuring WMA Quality Settings

The WMA Quality settings tab displays before burning a WMA music disc. On this tab, configure the settings as follows:

- **Quality**: select the sound quality of the WMA files that are burned to the disc from the drop-down.
• **Auto-generate playlist**: select this option if you want CyberLink Power2Go to create a playlist with the songs that will be on your disc.

### Configuring Library Settings

The Library settings tab is available in the settings window when creating a music disc. On this tab, you can set the monitored folders used in the CyberLink Media Library. When you add a folder, CyberLink Power2Go organizes the music in the folder (and any music added later) by artist, album, genre, year, and recently added so it is easier to find when creating a music disc.

To add a folder to the CyberLink Media Library, select **Burning > Settings** from the menu while creating a music disc. Next, select the **Library** tab and then click **Add**. Select the folder you want monitored in the CyberLink Media Library and then click **OK**.

### Configuring Video Settings

The Video* settings tab displays if you select **Burning > Settings**, or Ctrl+I on your keyboard, when in the Create Disc window. On this tab, configure the settings as follows when burning a VCD or DVD to disc:

**GPU acceleration preferences**

- **Enable hardware video decoding* (if available)**: if your computer supports Intel Core i7, NVIDIA CUDA, or AMD Accelerated Parallel Processing, select this option to use hardware acceleration to decode video to speed up the creation of video discs.

- **Enable hardware video encoding* (if available)**: if your computer supports Intel Core i7, NVIDIA CUDA, or AMD Accelerated Parallel Processing, select this option to use hardware acceleration to encode video to speed up the creation of video discs.

*Note*: * optional feature in CyberLink Power2Go. Check the version table for detailed versioning information.

### Configuring Common Settings

The Common settings tab displays before burning most of the disc types. On this tab, configure the settings as follows:
• **Disc name**: enter a name for the disc. The disc name appears on a disc player during playback.

• **Use the original date and time**: select this option to use each file’s original date and time for the date info used for the files burned on the disc.

• **Use the current date and time**: select this option to use the current date and time for the date info used for the files burned on the disc.

• **Use this date and time**: select this option to manually enter a specific date and time in the fields provided for the date info used for the files burned on the disc.

---

**Configuring Burner Settings**

The **Burner** settings tab displays before burning most of the disc types. On this tab, configure the settings as follows:

• **Burner**: displays the burner that CyberLink Power2Go will use to burn the disc.

• **Write speed**: select a write speed from the drop-down list. The speeds that are available is dependent on the drive installed in your computer.

• **Copies**: enter the number of copies of the disc you want to burn.

• **Enable buffer underrun protection**: select this option to ensure that data is written to disc without interruption. (An interruption in data can result in an unusable disc.)

• **Write simulation before burning**: select this option to perform a write simulation first to verify that your burner can burn to the disc at the selected speed without encountering any errors.

---

**Note**: if you have enabled buffer underrun protection or have previously burned discs using the current settings, you do not need to run a simulation.

• **Close disc**: select this option to write-protect a disc. Once burned, no further data can be added to the disc. If you do not select this option, you can create a multisession disc. See [Multisession Discs](#) for more information.

• **Verify recorded data**: select this option if you want CyberLink Power2Go to verify that the content was successfully burned to the disc. Select **Quick verification** to have CyberLink Power2Go quickly verify the correctness of the
data, or **Complete verification** to check all of the data individually. The latter requires more time to complete the verification.

- **Enable defect management**: select this option to have CyberLink Power2Go try to fix any defects on a disc so that content burns correctly.
Chapter 12:

Technical Support

This chapter contains technical support information. It includes all the information to find the answers you need to assist you. You may also find answers quickly by contacting your local distributor/dealer.

Before Contacting Technical Support

Please take advantage of one of CyberLink’s free technical support options:

- consult the user’s guide or the online help installed with your program.
- refer to the Knowledge Base in the Support section of the CyberLink web site.

http://www.cyberlink.com/prog/support/cs/index.do

The FAQs may have information and helpful hints that are more current than the User Guide and online help.

When contacting technical support by email or phone, please have the following information ready:

- registered serial number (Your serial number can be found on the CD cover, the box cover, or in the email received after you purchased CyberLink products on the CyberLink store).
- the product name, version and build number, which generally can be found by clicking on the product name image on the user interface.
- the version of Windows installed on your system.
- hardware devices on your system (capture card, sound card, VGA card) and their specifications.
- the wording of any warning messages that were displayed (You may want to write this down or take a screen capture).
- a detailed description of the problem and under what circumstances it
occurred.

**Web Support**

Solutions to your problems are available 24 hours a day at no cost on the CyberLink web sites:

*Note: you must first register as a member before using CyberLink web support.*

CyberLink provides a wide range of web support options, including FAQs, in the following languages:

<table>
<thead>
<tr>
<th>Language</th>
<th>Web Support URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>English</td>
<td><a href="http://www.cyberlink.com/prog/support/cs/index.do">http://www.cyberlink.com/prog/support/cs/index.do</a></td>
</tr>
<tr>
<td>Traditional Chinese</td>
<td><a href="http://tw.cyberlink.com/prog/support/cs/index.do">http://tw.cyberlink.com/prog/support/cs/index.do</a></td>
</tr>
<tr>
<td>Japanese</td>
<td><a href="http://support.jp.cyberlink.com">http://support.jp.cyberlink.com</a></td>
</tr>
<tr>
<td>Italian</td>
<td><a href="http://it.cyberlink.com/prog/support/cs/index.do">http://it.cyberlink.com/prog/support/cs/index.do</a></td>
</tr>
<tr>
<td>German</td>
<td><a href="http://de.cyberlink.com/prog/support/cs/index.do">http://de.cyberlink.com/prog/support/cs/index.do</a></td>
</tr>
<tr>
<td>Spanish</td>
<td><a href="http://es.cyberlink.com/prog/support/cs/index.do">http://es.cyberlink.com/prog/support/cs/index.do</a></td>
</tr>
</tbody>
</table>

*Note: CyberLink’s user community forum is only available in English and German.*
Index

A

Always on top 8
Audio 48
  extracting 19
  gap between tracks 48
  normalizing volume 48
  supported formats 3
Audio CD
  burning 19
  settings 48

B

Back up 33
Buffer underrun protection 50
Burn 19
  audio CD 19
  copies 50
  data discs 15
  discs images 37
  DVD folder 27
  mixed discs 40
  multisession discs 46
  music disc 19
  photo disc 29
  secured data disc 16
  settings 50
  simulation 50
  video disc 21

C

Capacity
  customize 12
Common settings 49
Copy disc
  overview 10

D

Data
  backing up 33
Data discs
  burning 15
  overview 9
  secured 16
  settings 47
DirectorZone 23
Disc menus
  adding music 23
  buttons per page 25
  customize 23
  duration 24
  first play video 24
  modifying text 23
  music duration 24
  preview 23
Disc utilities
  overview 10
  using 39
Discs
  auto-run 47

writing speed 50
Discs
  auto-split 47
  burning images 37
  capacity 12
  change icon 47
  closing 50
  date and time 50
  defect management 51
  erasing 39
  multisession 46
  naming 50
  photo gallery 29
  ripping audio 39
  supported formats 3
  supported types 4
Duration
  disc menus 24

E
Erase discs 27, 39
Extract
  audio 19
  file from image 46

F
First play video 24

G
Gadget
  burning tips 8

H
Hardware acceleration 49

I
Images
  burning 37
  disabling mounted 43
  mounting 43
  saving 36
  supported formats 3
  viewing contents 45
ISO
  format 37
  viewer 45

L
Language
  UI 12
Library settings 49

M
Media
  searching for 10
Mixed disc 40
Mixed mode CD 41
Modes
gadget 6
overview 6
Power2Go 9
Mount image 43
MP3 disc settings 48
Multisession discs 46
Music
gap between tracks 48
library 49
retrieving song info 12
ripping to hard drive 39
Music disc
burning 19
overview 10
Preferences 12
Preview disc menus 23
Projects
saving 11
R
Restore 34
S
Save disc project 11
Search
library settings 49
Search pane 10
Secure browser 17
Settings 49
audio CD 48
burner 50
common 49
data discs 47
library 49
MP3 disc 48
video disc 49
WMA quality 48
System recovery 33
System requirements 4
T
Temporary directory 12
TV format 26
N
New features 1
NTSC 26
P
PAL 26
Photo disc 29
Photo gallery disc 29
burning 29
overview 10
viewing 32
Playlist
MP3 disc 48
WMA quality 48
U

Ui language 12
User preferences 12
Utilities
  overview 10
  using 39

V

Video disc
  burning 21
  overview 10
  settings 49
Videos
  extracting audio 19
  supported formats 3
Virtual drive 43
Volume
  normalizing 48

W

WaveEditor 19, 41
WMA quality
  settings 48
Write
  simulation 50
  speed 50